### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abacus Training Manual 2012</td>
<td>1</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>1</td>
</tr>
<tr>
<td>What is it we do exactly?</td>
<td>3</td>
</tr>
<tr>
<td>Duties include</td>
<td>3</td>
</tr>
<tr>
<td>Financial Information</td>
<td>5</td>
</tr>
<tr>
<td>Start and End of Shift</td>
<td>6</td>
</tr>
<tr>
<td>Before your shift starts</td>
<td>6</td>
</tr>
<tr>
<td>It’s time to start now</td>
<td>6</td>
</tr>
<tr>
<td>The end of your shift</td>
<td>6</td>
</tr>
<tr>
<td>If it’s 9pm (or 5pm on weekends)</td>
<td>6</td>
</tr>
<tr>
<td>Staff Software</td>
<td>7</td>
</tr>
<tr>
<td>Microsoft Outlook</td>
<td>7</td>
</tr>
<tr>
<td>Adding OASIS Blog RSS Feeds</td>
<td>9</td>
</tr>
<tr>
<td>Desktop Monkey</td>
<td>10</td>
</tr>
<tr>
<td>Monkey – Staff Kiosk</td>
<td>10</td>
</tr>
<tr>
<td>Monkey Knowledge Base (KB)</td>
<td>10</td>
</tr>
<tr>
<td>Timesheets</td>
<td>11</td>
</tr>
<tr>
<td>Staff Contacts</td>
<td>11</td>
</tr>
<tr>
<td>Object Map</td>
<td>11</td>
</tr>
<tr>
<td>Support Software and Websites</td>
<td>14</td>
</tr>
<tr>
<td>hp OpenView</td>
<td>14</td>
</tr>
<tr>
<td>Incidents</td>
<td>14</td>
</tr>
<tr>
<td>Service Calls</td>
<td>15</td>
</tr>
<tr>
<td>HP Service Desk Call Classification System</td>
<td>19</td>
</tr>
<tr>
<td>OASIS Staff Portal</td>
<td>20</td>
</tr>
<tr>
<td>Displaying Account Info</td>
<td>21</td>
</tr>
<tr>
<td>Resetting Accounts</td>
<td>21</td>
</tr>
<tr>
<td>Citrix – StudentOne and CARDAX</td>
<td>22</td>
</tr>
<tr>
<td>Cardax</td>
<td>23</td>
</tr>
<tr>
<td>Most Common Swipe Card problems</td>
<td>24</td>
</tr>
<tr>
<td>Curtin User Support Tool (CUST)</td>
<td>26</td>
</tr>
<tr>
<td>CMS IP Remote</td>
<td>26</td>
</tr>
<tr>
<td>Login using your STAFFID in both Username and Password fields</td>
<td>26</td>
</tr>
<tr>
<td>The Phones</td>
<td>27</td>
</tr>
<tr>
<td>To use the Handset</td>
<td>27</td>
</tr>
<tr>
<td>To put a caller on hold</td>
<td>27</td>
</tr>
<tr>
<td>To make an inquiry call</td>
<td>27</td>
</tr>
<tr>
<td>To transfer a call</td>
<td>27</td>
</tr>
<tr>
<td>To dial an STD or mobile number</td>
<td>28</td>
</tr>
<tr>
<td>Oasis Central</td>
<td>29</td>
</tr>
<tr>
<td>Student Websites and Software</td>
<td>31</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Oasis</td>
<td>31</td>
</tr>
<tr>
<td>Blackboard (LMS) – Admin Tools</td>
<td>32</td>
</tr>
<tr>
<td>Library</td>
<td>33</td>
</tr>
<tr>
<td>Endnote</td>
<td>33</td>
</tr>
<tr>
<td>Student Email (Live@Edu)</td>
<td>34</td>
</tr>
<tr>
<td>The Labs</td>
<td>38</td>
</tr>
<tr>
<td>Building Maintenance and Cleaning Problems</td>
<td>38</td>
</tr>
<tr>
<td>Maintenance Problems</td>
<td>38</td>
</tr>
<tr>
<td>Cleaning Problems</td>
<td>38</td>
</tr>
<tr>
<td>Computer Problems</td>
<td>39</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>39</td>
</tr>
<tr>
<td>Reporting the Problem</td>
<td>39</td>
</tr>
<tr>
<td>Wireless Problems</td>
<td>39</td>
</tr>
<tr>
<td>Conditions of Use of ICT Equipment</td>
<td>42</td>
</tr>
<tr>
<td>Procedure – Abuse</td>
<td>43</td>
</tr>
<tr>
<td>Emergency Evacuation</td>
<td>45</td>
</tr>
<tr>
<td>Lost Property</td>
<td>47</td>
</tr>
<tr>
<td>Printers</td>
<td>47</td>
</tr>
<tr>
<td>Printer Problems</td>
<td>47</td>
</tr>
<tr>
<td>Occupational Health And Safety</td>
<td>48</td>
</tr>
<tr>
<td>Bullying</td>
<td>48</td>
</tr>
<tr>
<td>Prevention &amp; Management of Bullying @ Curtin</td>
<td>48</td>
</tr>
<tr>
<td>EduSafe</td>
<td>49</td>
</tr>
<tr>
<td>Making the Workplace Safe</td>
<td>50</td>
</tr>
<tr>
<td>Safety At Work</td>
<td>50</td>
</tr>
<tr>
<td>Safety Priorities for Manual Handling</td>
<td>51</td>
</tr>
<tr>
<td>Passwords Quick Reference</td>
<td>52</td>
</tr>
</tbody>
</table>
What is it we do exactly?

Abacus staff are required to work in any of the Abacus open access computer labs in 303, 408, 501 and the 402 and 204 offices providing counter and desktop ICT support to students. Staff also answer the overflow of phone calls made to the OASIS Central call centre which supports the OASIS student portal.

Duties include

Student Support

- Assisting students with general ICT problems, commonly used software such as Office, browsers, printing and card-reader issues, logging on to the OASIS student portal, technical queries relating to items in the portal such as email, FTP etc.
- In response to Oasis Central calls, assisting students with issues relating to the OASIS student portal as described above.

More general ICT support cannot be provided over the phone as we cannot be held responsible for mucking up their computer.

- Logging and responding to help desk calls received by phone, over the counter and via web form. Details of every call should be captured in Desktop Monkey or logged in HP OpenView complete with full information, comments, follow-up and resolution.
- Escalating calls that cannot be resolved by Abacus to BSSUPPORT and directing non OASIS/ICT queries to appropriate business areas. eg enquiries regarding enrolment or other administrative matters relating to a course should be referred to that Divisional Student Services Office.
Know the answers

- Become familiar with the contents of OASIS help pages
- Become familiar with the Knowledge Base in Monkey
- Become familiar with various procedures
- Monitor personal staff and OASIS email accounts on an ongoing basis to keep informed.

Lab Supervision

- Walking around the labs regularly, offering assistance where needed and at the same time discreetly checking for activities listed as prohibited.
- Using RemotelyAnywhere software to monitor suspicious activity and capture screens where necessary.

Lab Supervision - Visiting Room 325 (Equity Labs)

- Staff working the 9-1 shift in 303 must visit Room 325 (formerly Equity) between 12pm & 1pm EVERY weekday.

Lab Maintenance

- Ensuring printers are filled with paper and toner cartridges are replaced as necessary. Check stocks of paper and cartridges and email Bills when low.
- Reporting any computer hardware or technical problems to Bills.
- Reporting any buildings maintenance issues such as swipe door access, power, air-conditioning, plumbing or cleaning problems to Bills.
- Ensuring all students vacate the labs in an orderly fashion in the event of the alarm sounding for a fire-drill or any kind of real emergency.

Lost Property

- Students may hand in lost property left in or around the labs or staff may find it when walking around the lab.
- Lost property is to be put in a paper box in the lost property box of each lab and taken to student central daily.
Financial Information

http://abacuslab.curtin.edu.au/staff/timecard/

To get paid we need to fill out a timesheet once a fortnight for the previous fortnight’s work, and you will be paid the week after you submit your time sheet. Your hours will be automatically recorded by Desktop Monkey (when you clock in and out) and entered into your timesheet ready for you to print out. Don’t forget to clock in and out!

Your timesheet can be altered to reflect lunchbreaks etc., but must not be altered inaccurately.

** If you are working an 8 hour shift you must take a half hour break. HR will not pay you for any more than 7.5 hours in one day **
Start and End of Shift

Before your shift starts
- Log onto the computer using the administrator username and password.
- Log into Desktop Monkey. Clock in.
- Open Microsoft Outlook and log in.
- Log into JET and open an external webpage.
- Log into MSN messenger.

It’s time to start now
- Open your window (if it’s closed)
- Log into HP OpenView and check for unresolved calls assigned to ABACUS.
- Take a walk. Check all machines, that network and power cables are plugged in, printers filled etc. Clean up anything that’s lying around. Make sure all tables have a chair.

The end of your shift
- Check HP OpenView for any calls you missed.
- Check the printers – Fill them up to the line.
- Tidy up after yourself (and everyone else) in the office.
- Tell whoever is working the next shift about any problems encountered and leave a note in the office diary.

If it’s 9pm (or 5pm on weekends)
- Log off and lock the phone.
- Close the shutters
- Turn out the lights
- Lock the doors, double tap for 303, 408. Single for 501
Microsoft Outlook

Username: Staff ID
Password: Oasis password (Bills will give you this)

Microsoft Outlook is used across campus for staff email. You will need to have Outlook open all the time to receive information and reminders.

Your Curtin staff email address will usually be
(first initial).(lastname)@curtin.edu.au
eg a.cox@exchange.curtin.edu.au

All Abacus staff are on the Abacus mailing list (abacus@curtin.edu.au). To send an email to all staff (including Bills) just put “Abacus” in the To: field.

If you have any problems with pay rates, hours worked, your contract, conditions of employment etc, please contact Bills directly.

Dave handles the rosters, so for any matters related to shifts contact him directly.

Your Outlook account will tend to fill up quickly so try to keep it as organised as possible. Setting up appropriate folders will ensure you will always be able to find what you’re looking for.
To Setup your Outlook Mailbox

Setting mail signature

- Click "Tools" > "Options" > "Mail Format" > "Signatures"
- Click New, give the signature the name "OASIS Central"
- Paste the OASIS Signature (below) into the text box
- Click "Finish" and "OK"
- In the dropdowns for “Signature for new messages” and “replies and forwards” select “OASIS Central”

Oasis Central Inbox

The Oasis Central Inbox is where all Oasis Central correspondence comes to and leaves from.

To set up your Oasis Central Inbox

- To add it ... you need to close Outlook, go to Control Panels -> Mail -> Email Accounts
- On the Email Tab click New in the top left -> Email Account -> Next -> Manually Configure -> Next
- Select Microsoft Exchange or compatible service -> Next
- In the Server name field put exms1.curtin.edu.au and the username field type OASIS and click check name.
- Select OASIS Central and OK out. I suggest unticking “cached mode” as it takes forever to sync all the mail.
- Open up Outlook (which will be quite slow) and in your folders list you will now have OASISCentral@exchange.curtin.edu.au
- To send as OASIS Central you need to have the From field turned on
Adding OASIS Blog RSS Feeds

This needs to be done once per admin machine.

Step 1 – right click on RSS Feeds and select “Add a New RSS Feed”

Step 2 – add the three OASIS feeds

https://blog.curtin.edu.au/oasis/rss.cfm?mode=full&mode2=cat&catid=BB6D6B0B-FAFE-6CC5-37344F7AD2E6FAF8


You will be asked for your username and password – normal staff ID and password and select “Save my credentials” if asked

Step 3 – the three feeds are now synchronised, as you read each article they are marked as read and you can remove posts you don’t need. Once you have set up RSS on your account it will sync anytime you log onto any staff machine.
**Desktop Monkey**

http://abacuslab.curtin.edu.au/staff/desktop/desktop.cfm

*Username:* Staff ID  
*Password:* monkey password (Bills will give you this)

Desktop Monkey is the web interface on your computer desktop. We use it to clock in and out (so you don’t have to remember) and to log shift and query statistics.

To use Desktop Monkey you **must** remember to Log in and then Clock in.

**Monkey – Staff Kiosk**

http://abacuslab.curtin.edu.au/staff

*Username:* Staff ID  
*Password:* monkey password

The Monkey website is our staff website. On here you will find:

**Monkey Knowledge Base (KB)**

http://abacuslab.curtin.edu.au/staff/kb/

The KB is filled with articles, procedures and policies covering just about everything you will need to know working in the Abacus Labs. This should be your second stop if you have a question (after asking whoever you’re working with).
All staff can add articles to the KB, so if you think something is missing feel free to put it in.

**Timesheets**

Timesheets are accessed through Staff Kiosk in Oasis. Choose Timesheets → Casual Timesheet
Click to add new timesheet → Start Date
Enter the first day of the pay period (Always a Thursday)
Enter all hours of work, including lunch breaks in the breaks section, including Paycode which is 221
Once complete click Save and Submit.

**Staff Contacts**


Get phone numbers, email and MSN details here.

**Object Map**


Object Map can be used to perform a number of different functions for staff. The first is to keep a record of details of the computer and so we can check the status of each computer in the lab. It is imperative that staff keep this information up-to-date and record any changes in the status of the computers.

Below is an example of what monkey records for a given PC:

<table>
<thead>
<tr>
<th>Top of Form</th>
<th>Type: PC or other:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title:</td>
<td>(this is what the object will be labelled with on the map)</td>
</tr>
<tr>
<td>Model:</td>
<td>Dell Optiplex GX520 or other:</td>
</tr>
<tr>
<td>Lab:</td>
<td>Abacus 303 South</td>
</tr>
<tr>
<td>IP Address:</td>
<td>134.7.118.134 (leave blank if not applicable)</td>
</tr>
</tbody>
</table>
Abacus Training Manual 2012

Serial No 1: 0013.72DF.1538 (for Dells, this is the MAC Address)
Serial No 2: (for Dells, this is the Product Key/OEM Number)
Serial No 3: 45kyk1s (for Dells, this is the Service Tag)

For Loan: ✔️ (Leave this checked unless the object is bolted down)

Status: OK

Comments:

show/hide history
232109d (22/08/2008): Ghosted and back in lab! - reubz
233942j (22/08/2008): updated mac address with 0013.72DF.1538

History:
238008f (21/08/2008): thermal event.
217644h (21/08/2008): new mobo
238005a (15/08/2008):
238005a (15/08/2008): Thermal event. Taken behind the desk for investigation.

Reuben Dias at 13:31:55 Friday, August 22, 2008

Last edit: Bottom of Form

As you can see the History records information about any changes in the status of the computer, such as installation of a new motherboard or if it has had a thermal event.

The Other use for Object Map is to view remotely (ie: from your desk) what any student in you lab is looking at. This is used in circumstances where a staff member has viewed suspicious behaviour by a student.

To do this follow these instructions:

- Log into monkey http://abacuslab.curtin.edu.au/staff
- Click Object Map from the Navigational Menu on the left
- Find the appropriate computer in question
- Right click the computer and click “Poo This PC”
- Enter Administrator and user passwords into both prompts.
- Click Computer management
- Click Monitor Host Screen to view what the student is looking at
This is to be used in a specific set of circumstances it is not to be used for malicious purposes such as; Reading someone else’s emails, looking at bank details etc.. Any Such behaviour will result in an immediate breach of contract and appropriate action will be taken.

To move a computer from one part of the lab to the other, i.e. if a computer has been taken behind the office for maintenance.

- Move the objects in monkey into the correct positions (ie move 6012 to the office in the map and 6082 (spare) into its position in the map)
- If you are moving machines from one lab to another (ie 303a to 303b)
- Edit the object (right click->Edit details for this PC) in monkey and change the lab in the "Lab" dropdown
- Update and return to map and move into the correct position.
- If you drag the machine object from one lab to another in the map, the object will become un-editable and locked in the database - that needs to be undone by Business Solutions.
Support Software and Websites

hp OpenView

Username: oasisX (check the sticker on your computer)
Password: same as the username

This software is used throughout the University to log support calls. Each call has contact details and detailed information about problems that students and staff encounter, usually with ICT (Information and Communication Technology) facilities.

At Abacus we deal with Service Calls and Incidents related to student problems. To view either of these, select the Incident icon in the panel on the left.

Incidents

Incidents are urgent problems affecting a lot of people. They are created and assigned in a similar manner to Service Calls, the difference being that Incidents can have multiple Service Calls related to them.

To relate a Service Call to an Incident

- Open the Incident
- Click on the Relations tab
- Click on the Relate button
- Select a Relation Type
- In Service Call type in the Service Call ID number that you wish to relate to the incident.
- Click OK
**Service Calls**

Service Calls are general problems raised, usually not affecting more than a couple of people. You can view calls assigned to Oasis Central by selecting OASIS Central Open Service Calls from the drop-down menu at the top of the program, and those assigned to Abacus by selecting ABACUS Open Service Calls. The calls assigned to Abacus are calls that Oasis Central have not been able to solve. If you feel there’s a really straight-forward solution add it to the History and send it back to Oasis Central by changing To Workgroup to Oasis Central.

Double click on the call Description to open the call. Read the Information box carefully, and check for any entries in the History box. Also check the Solution, Closure tab to see if anyone has entered anything here.

**How to reply to OpenView Calls.**

The following is a guide to answering OpenView calls. Please have a read of it and if you have any questions please don’t hesitate to ask.

Please follow these guidelines when writing an email reply to an OpenView query:

1. Include the 'Description' from the HPOV call in the Subject of the new email, along with the Call ID. Set the email 'From' field to "OASIS Central" - otherwise it will be sent from you and you may get a student replying to you personally, and may contact you in the future with queries. Don’t forget to spell check and ensure that you are using professional language.

    eg:
    From... OASIS Central
    To... silly.student@student.curtin.edu.a
    Subject: OASIS Login Assistance - Call ID: 39000
2. Copy the entire 'Information' box into your email reply. This makes it easier to follow if the person writes back again.

eg: Hi Student,

The reason you are unable to log into Oasis is......

Regards,

OASIS Central
Curtin University of Technology
Kent Street, Bentley WA 6102
Tel: 9266 1222 (Perth) 1300 66 32 38 (Australia)
9am - 9pm weekdays
1pm - 5pm weekends

----------------------------------------------

Student Number: 12121212
First Name: Student
Family Name: Smith
e-mail: studentsmith@gmail.com

This support call was raised from outside the OASIS application.

________________________________________

I cannot log into Oasis
Operating System: Microsoft Windows
Browser: Microsoft Internet Explorer 6.0 (cookies enabled, JavaScript enabled)

3. Copy your reply & paste it into the 'Solution,Closure' section of the OpenView call with

YOUR NAME.

This way there is always a record of what was sent to the student. It is also helpful to include the time & date that you emailed the student, and your name.

eg:

Emailed student at 10:45am on 28/7/07 - Jen Hogan
Hi Student,

The reason you are unable to log into Oasis is......

Regards,

**OASIS Central**

Curtin University of Technology

Kent Street, Bentley WA 6102

Tel: **9266 1222** (Perth) **1300 66 32 38** (Australia)

9am - 9pm weekdays

1pm - 5pm weekends

4. Set the 'Status' of the OpenView call to 'Closed' once you have sent the email. Do not use any of the other settings if the call is closed. ie Resolved.

5. Move the email from your 'Sent Items' to the 'Helpdesk Responses' folder in the OC Inbox.

-----------------------------------------------------------------------------------------------------------------------------------

This guide can be followed closely for simple calls. For more complex calls where the student is likely to respond e.g. if you have emailed the student asking them for more information, then please do not close the call. Instead, copy your email reply and paste it into the ‘History’ section of the call, rather than the solution/closure' section, with your name and ‘Abacus’ and set the call status to "waiting client" and the "to person" to abacus303n. If a student doesn’t reply after 4 or 5 days, then the call can be closed due to a lack of response.

-----------------------------------------------------------------------------------------------------------------------------------
Creating a New Service Call

1. Launch HP Openview from the icon on desktop or toolbar
   * Username: based on location (eg OASIS06)
   * Password: Same as username

2. Click File -> New -> Service Call
   STAFF Choose template: ICT -> CIS Standard
   STUDENTS Choose template: STUDENTSUP -> Oasis Default

3. Logging calls: important fields
   Caller details: specify everything applicable/available. Avoid mobile numbers.
   (For staff, enter their surname in the Caller field and press TAB – this will fill-in the details.)
   Description: Summary of the problem. Make sure you include the student/staff ID and your name so that we can follow up if necessary.
   Information: Details (provide as much as possible), also include student/staff ID.
   Service (dropdown)
   Priority (High, Medium, Low)
   Assignment: All calls must be assigned to one of these workgroups

### STUDENTS

<table>
<thead>
<tr>
<th>Workgroup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OASIS CENTRAL</td>
<td>Any calls not closed that Oasis Central will be able to resolve</td>
</tr>
<tr>
<td>ABACUS</td>
<td>Calls that you cannot close, but another Abacus staff member can</td>
</tr>
<tr>
<td>BSDEVELOPMENT</td>
<td>Calls that cannot be resolved by Abacus staff</td>
</tr>
</tbody>
</table>

### STAFF

<table>
<thead>
<tr>
<th>Workgroup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBSHELPDESK</td>
<td>Any calls from CBS staff</td>
</tr>
<tr>
<td>ENGCOMPUTING</td>
<td>Any calls from Engineering &amp; Computing staff</td>
</tr>
<tr>
<td>HEALTHHELPDESK</td>
<td>Any calls from Health Sciences staff</td>
</tr>
</tbody>
</table>
Any calls from Faculty of Science staff

<table>
<thead>
<tr>
<th>SCIENCE</th>
<th>Any calls from Faculty of Science staff</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCITSUPPORT</td>
<td>Any calls from Vice-Chancellory or regional campuses (Kalg, Muresk)</td>
</tr>
</tbody>
</table>

4. Save and close the call, and provide the service call number to the caller for future reference.

If the client’s call raised an issue related to a server failure [that affects everyone], you must raise an incident in order to alert relevant on-call staff who will be able to fix the server. Please follow the procedures in Incident Management [170].

**HP Service Desk Call Classification System**

The Student eServices Team have implemented a new classification system for HP Service Desk Calls assigned to the team. Each service call will be defined by an umbrella term. This term will be located within the "description" field of the service call.

This classification is purely for reporting and reference purposes to allow eServices to identify what type of service calls we are dealing with in a defined period of time. Outlined below are the umbrella terms of classification and also what kinds of service calls would be expected to classified under each:

- **Ask Curtin** - Calls related to Ask Curtin and other FAQs.
- **Blackboard** - Calls related to issues regarding Blackboard.
- **Drive General** - Issues regarding i:drive.
- **Drive Quota** - Calls related to a request for an increase in an i:drive quota.
- **Email Name Change** - Calls related to forcing a name change to an email address.
- **Email Quota** - Calls related to a request for an increase in email storage space.
- **Email General** - All other email related calls (ie access, errors, etc).
- **eStudent** - Calls related to Student 1 and eStudent.
- **Internet Quota** - Calls related to JET Quota.
• OASIS Access - Calls related to an inability to access the OASIS portal.
• OASIS Functionality - Calls generally related to aspects of OASIS that students or staff have suggested changes too.
• OASIS General - Other OASIS issues (ie inability to access tabs, etc).
• OASIS Login - Calls related to an error received when logging in or account activation.
• OASIS Permissions - Calls related to issues regarding a student’s role.
• Staff Permissions - Calls related to providing Curtin staff with OASIS access permissions
• Wireless Network - Calls related to the Curtin Wireless Network.

This list of terms may change over time so please reacquaint yourselves with this list on a regular basis for reference.

**OASIS Staff Portal**

https://oasis.curtin.edu.au

*Username:* Staff ID  
*Password:* Activate it using the link on the login page

OASIS Staff Portal is used to confirm details held in OASIS. It includes a student's activation status, contact details and password status. It can be used to reset an OASIS password providing proof of identity is provided.

Passwords can be reset by following the “Forgot my Password” process, similar to the OASIS process. If they have tried this unsuccessfully, you can reset their password through this Portal.
Make sure you ask wallet and non-wallet questions. Wallet questions can be located in UserLookup. But, you will also need to log in to Citrix Student One to ask non-wallet questions.

<table>
<thead>
<tr>
<th>Standard questions for ALL students:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Full legal name exactly as supplied when you enrolled</td>
<td></td>
</tr>
<tr>
<td>• Curtin University Student ID Number</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>THEN ASK</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>At least 1 wallet question</td>
<td>At least 3 non-wallet questions</td>
</tr>
<tr>
<td>• Date of Birth</td>
<td>• What units did you study last semester?</td>
</tr>
<tr>
<td>• Phone Number(s)</td>
<td>• What units are you studying this semester?</td>
</tr>
<tr>
<td>• Full Postal Address</td>
<td>• Did you pass or fail unit X (eg Accounting 100)?</td>
</tr>
</tbody>
</table>

**Displaying Account Info**

You can search for a student using various fields (Curtin ID, first name, last name).

**Resetting Accounts**

- Ask student if they’ve used the “forgot my password” link on the OASIS website. If they haven’t, ask them to do this.

- If a student visits the counter, take their student card to confirm details. If they want a reset over the phone, verify their details using wallet and non-wallet questions (see Citrix Student One).

- If they forgot the answer to their Secret Question, or had other problems with “Forgot my Password”, log into Oasis and click the “My work” tab. Under “User Lookup”, enter their ID and press search.

- This will come up with a row containing OASIS account information for the student.

- **If OASIS Account Activated = no** they’ll need to set up their account again - see “Setting up OASIS accounts.” This may be because their account was removed then added again as they returned late or changed enrolment details.
If OASIS Account Activated = yes click the ‘reset password’ button, and open an OASIS page for them to ‘activate their account’ again (or prompt them to do so at home). Their username is still their Student number, their password is their DOB until they set up a new password.

**Citrix – StudentOne and CARDAX**

https://nfuse.curtin.edu.au/

Citrix Student One is used to confirm details held in StudentOne such as student identity and enrolment status.

**Launcher**

*Username:* Staff ID  
*Password:* Oasis Password

**Production**

*Username:* Staff ID  
*Password:* Password set on activation

If you are unable to log into Citrix, or you cannot see any icons after login, call x4000

**Viewing current student status/enrolment**

- Click on the S1 folder, then on the S1 production icon.
- Login at the Launch screen.
- Select the ‘REPORT’ tab.
- Click on the ‘Student verification Report’ link
- Enter the student number in the field “Student Number” and press the “Start Processing” button to generate report. This will open a new window where you can find non-wallet questions.
Cardax


Log in to Citrix first. Then Log in to Cardax with:

**Logon Name:** (all uppercase) Your staff ID eg: 123456A  
**Password:** Your personal CARDAX password

Cardax FT Command Centre will appear in a new window. Click on Monitor, then Event Viewer. This will open a new window displaying current Cardax activity.

**Note:** To ensure the Event Viewer window stays at the top, click on the whitespace as far to the right of the window as you can.

**To Search for a Cardholder:**

- Click on Monitor, then Find
- In “Name” section, type in the surname you are searching for.
- In “Look in” section, click drop down arrow and select “Cardholder”
- Click “Start Search”
- A list will appear at the bottom of the window.
- In this “Card” view you will be able to see the cardholder’s:
  - Issue number: Normal procedures apply if the issue number is not updated. **DO NOT CHANGE ISSUE NUMBER.**
  - Expiry date: Normal procedures apply. **DO NOT CHANGE EXPIRY DATE.**
To Activate Access To Abacus Labs:

You should not need to do this as we have been told all students are given this access automatically.

- To check if they have Abacus Lab access:
- Search a student
- Double-click on cardholder’s name
- Select the “Access Groups” tab.
- An access group called “Abacus Labs” should be listed.
- If for some reason they do not have the Abacus Lab access group:
  - Keep the “Access Group” view open.
  - In the main Cardax menu toolbar, click on “Manage”, then “Access Groups”
  - A new window with all possible Access Groups will appear.
  - Open the group called “Cardholders (No Access)+ Personal Data” and click on “Abacus Labs”.
  - Drag “Abacus Labs” to the cardholder’s list of access groups in the “Access Group” view.

Forgot your CARDAX FT password:

Please email Properties System Support at PropertiesSystemSupport@curtin.edu.au

Most Common Swipe Card problems

To check what the problem is
- Have the Event Viewer open
- Ask the student to swipe their card three or four times in a reader – it doesn’t matter which door, just as long as you can identify it in Event Viewer

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>No name appears for that door</td>
<td>Damaged Card</td>
</tr>
</tbody>
</table>

24
If the card is scratched, bent or melted (don’t laugh, if you leave your wallet in the card on a hot day they melt real easy) then the card reader may not be picking it up. To check this

- If the reader makes no noise and no name appears for that door in the Event Viewer, the card is damaged.

The student will need to get themselves a new card from Student Central.

**Symptom** Wrong student’s name appears on Event Viewer

**Problem** Wrong student is encoded on the card

Sometimes the card is encoded with the wrong student’s details. This can be identified by asking the student to swipe their card a few times through any door. If the card is encoded wrong, a different name will appear for that door. Send the student to Student Central to get it fixed. Then laugh quietly to yourself at the fact that a boy’s card was coming up with a girl’s name.

**Symptom** Event Type: Unauthorised Card

**Problem 1** Student’s card has expired

Check student’s enrolment. If they are no longer enrolled, the student will not have access to the Abacus Labs.

If the student is still enrolled, send them to Student Central to have their card fixed.

**Problem 2** Student needs to be reauthorised

- Search for the student
- Double-click on the cardholder’s name
- Select the “Card” tab.
- Un-check the “Cardholder Authorised” box and click “Apply”. Re-check the box, click “Apply”, then OK.

**Symptom** Event Type: Invalid Card Issue

**Problem** Student’s issue number has not been updated.

The Issue Number refers to how many cards to student has had i.e.
- first card: Issue number = 1
- second card (replacement card): Issue number = 2

If the Issue number is incorrect (eg issue number = 1 when this is their second card) then one of two things has happened:

1. Student has gotten their new card in the last day or two: tell them to wait a couple of days for the new card to update
2. Student got their new card a while ago and the system has not updated it: send them to Student Central to fix it.

**Curtin User Support Tool (CUST)**

CUST (Curtin User Support Tool) is a tool which allows you to view information about all of a student’s accounts (Jet, Novell, AD etc) all in one place.

Use your normal staff OASIS account to log in

URL: http://oasis.curtin.edu.au/cust

Username: staff number (eg 220284e)

Password: set when you activate your account.

OASIS Passwords can be reset by following the “Forgot my Password” process, similar to the OASIS process. If they have tried this unsuccessfully, you can reset their password through CUST.

Make sure you ask wallet and non-wallet questions. Wallet questions can be located in OASIS. But, you will also need to log in to Citrix Student One to ask non-wallet questions.

On the actions tab you can reset a student’s password and resynchronize the account.

**CMS IP Remote**

This is a tool for checking print card status, reset printing PIN, credit and check transactions.

Login using your STAFFID in both Username and Password fields.

Check details – shows locked/unlocked status, current credit.

Change password – resets the password, the student will be prompted to enter a new password on the print release station.

View Transactions – Display all recent credit or debit transactions on the account, handy for checking credit disputes.
The Phones

Each phone in the Abacus Offices has its own extension (eg x3465).
You will be able to dial any number on campus by just dialling the extension
eg Student Central is at 9266 3399 – just dial 3399

To use the Handset

Ensure handset is on the hook.

To put a caller on hold

Press the button under the HOLD text

To make an inquiry call

(eg calling Bills to ask him a question while you still have someone on the line)

1. Put the caller on hold
2. Press <New Call>
3. Dial the required number
4. When you’re finished, press <EndCall> to hang up the inquiry call
5. Press the caller’s line (take them off hold).

To transfer a call

1. Press <TRANSFER>
2. Dial the required number
3. Tell the person the reason for the call
4. Press <Transfer> to transfer the call to the third party.
To dial an STD or mobile number

1. Dial 0
2. Dial the required number
3. eg *72*9320338# 0 0417177812

** This code is ONLY for phone calls necessary to assist a student **

Anyone misusing this service will be reprimanded.
Oasis Central

Oasis Central is the helpdesk service provided by Student Central to assist students with Oasis related problems.

Oasis support at Curtin is divided into three levels:

Tier One  
Oasis Central

Tier Two  
Abacus Labs

Tier Three  
Business Systems Support

A student’s first point of contact is Oasis Central (Tier One). OC can be contacted via

Email:  
oasiscentral@curtin.edu.au

These emails are delivered to the Oasis Central Inbox.

See the section on Microsoft Outlook for instructions on setting this Inbox up in your account.

Webform:  
at http://oasis.curtin.edu.au

Calls logged in the webform go to HP OpenView, and are assigned to OASIS Central. An email is sent to the Oasis Central Inbox to bring attention to the new call.

Phone:  
9266 1222

In person:  
Abacus Labs helpdesk.

Student Central handle Oasis Central emails, HP OpenView calls and phone calls during business hours

ie Mon – Fri, 9.00am – 5.00pm.

If the staff at Student Central have a problem with

A phone call  
OC will call us on x1010 for assistance

An OpenView call  
OC will assign the call to ABACUS.
Abacus Lab staff handle Oasis Central after hours

    ie Mon – Fri 5.00pm – 9.00pm and Sat/Sun 1.00pm – 5.00pm

Any calls that require more technical support that Abacus staff can provide are assigned to Business Solutions Support. For phone calls, emails and visits to the counter create a new OpenView call and assign it to Intel Systems Support (for Novell Problems) or Business Solutions Support (for everything else).

** Always check with , Bills or a senior member of staff before assigning calls to Business Solutions Support**
Student Websites and Software

**Oasis**

[http://oasis.curtin.edu.au](http://oasis.curtin.edu.au)

You should already be quite familiar with the Oasis Website. At the beginning of every shift you should log into Oasis and check your email to make sure everything is working.

Sections you need to be familiar with:

- Usage Requirements
- The *Forgotten Your Password?* link
- Account Management – Wireless Status, Password Reset and Network Connections Help
- eStudent
- Where to find everything

FLECS – Blackboard

- Students should access FLECS - Blackboard via OASIS using the “my studies & eVALUate” tab

FLECS – Blackboard is an online portals that provide individual websites for units. Students can access this portal

Follow the link in Oasis > My Studies & eVALUate > FLECS – Blackboard – student will not need to log in again
FLECS – Blackboard problems are divided into:

**Log in problems**

We are responsible for these. If the student is able to log into Oasis but not FLECS – Blackboard, an OASIS repair will usually fix the problem.

**Problems within the website**

Direct the student to their unit coordinator/lecturer for problems with individual units within FLECS – Blackboard.

---

**Blackboard (LMS) – Admin Tools**

If a student has a complaint in regards to a unit/s not appearing in blackboard and they are enrolled in e-student, the following can be done to make sure a blackboard unit exists.

**Procedure:**

- Go to: [www.lms.curtin.edu.au](http://www.lms.curtin.edu.au)
- Login with Staff ID
- Select ‘System Admin’
- Select ‘Course’ & fill in the appropriate fields to search for the unit

If the unit does in fact exist, refer the student to the lecturer or the unit co-ordinator so they can add them into the unit.

To question if a student is enrolled in a unit/s the following can be done to verify what unit/s they are enrolled in.

**Procedure:**

- Go to: [www.lms.curtin.edu.au](http://www.lms.curtin.edu.au)
- Login with Staff ID
- Select System Admin
- Select ‘Users’ & search the students ID number – the students name will then appear
- Select ‘Modify’
- Select ‘Course Enrolment’

A list of the units the student is currently enrolled in will appear. Units with Red Crosses marked next to them, indicate unit/s that were once available, but are currently not accessible.

**Library**

http://library.curtin.edu.au

The Library website is fairly self-explanatory. If a student needs to log in anywhere they will use their Oasis login. Any problems with this website can be dealt with by the library.

**Endnote**

http://library.curtin.edu.au/study-and-research-tools/endnote.cfm

Endnote is available from the library website, although the link on the Library page in Oasis is more reliable.

All support requests related to Endnote can be directed to the Library.
**Student Email (Live@Edu)**

Students are able to access their Live@edu email account via OASIS without needing a separate password, however, if a student wants to set up their email account to run through an external email client (ie Outlook), access their emails through their mobile device or use the Windows Live Messenger service, they will be required to use a Windows Live password.

Each student is allocated a Windows Live password when their Live@edu account was created, the Windows Live password can be found under the heading **Live@Edu - Windows Live Password** at the bottom of the **My Details** channel on the **Account Management** page.

A student will always be able to access their Live@edu email account via OASIS, although if they reset their initial Windows Live password (through one of the Microsoft Live applications) and forget this password, they will need to contact OASIS Central to have the password reset. The following procedure outlines the process for resetting a Windows Live password.

**Procedure:**

1. Ensure all students are successfully identified in accordance with the **Student Identification for OASIS Password Resets SSAP** using “Wallet” and “Non wallet” questions.

2. Once the student is successfully identified, confirm that it is the Windows Live password that the student needs reset (not the OASIS password). This can be confirmed by asking the student what they are trying to access with their Windows Live password, if it is simply student email they can be directed to OASIS.

3. Create a HPOV service call with the student’s details and a description: “Windows Live password reset” and details about the call.

4. Rest the password using the Windows Live Administration account, following the instruction and process below:
   a. Log in to your Windows Live Administration account from
   b. User name staffID@liveadmin.curtin.edu.au
      www.outlook.com
c. Click on **Options** in the top right hand corner

d. In the **Select what to manage**: dropdown, select **My Organization**.

e. Search for a student by name or email address. Note: the email address will only ever be “@student” regardless of whether the student is a postgrad or graduate. Email addresses can be pulled from Userlookup to assist with a search.

f. Click on the Reset Password option, a new window will open. Double click on the correct student. **Note**: if there are multiple students with
the same name, you will need to determine the correct student from their email address.

g. Advise the student of the password reset by email. The email **must** be sent to the students Curtin email account. **Note:** The student will need to log in to OASIS to access the email; they will be forced to set a new password upon login to Windows Live.
Should you have any queries about this procedure, please speak to the Student eServices team (student-eservices@curtin.edu.au or x8600).
Building Maintenance and Cleaning Problems

Maintenance Problems
To report building maintenance issues such as air-conditioning, doors not working or problems with the toilets adjacent to labs etc, email Bills and the Abacus mailing list with details of the problem. We will contact the SCC and have the problem logged.

If it is really important (eg the aircon is off and the lab is getting really hot) phone Bills. If Bills is available and the matter is urgent you may phone the SCC (x2020) and then email a summary to Bills.

Similarly, for urgent Cardax (eg the doors will not swipe open) you may call Security (x4444) or Matt the Cardax man (x3574). After hours just call Security. You may also call Bills’s mobile after hours if it is very important.

Make a note of the problem on the Monkey map, and in the notebook, if it’s something to do with an object in the lab. You can create a new object if appropriate.

Cleaning Problems
For reporting cleaning issues such as full garbage bins, poor general cleaning or full recycling bins etc, email Bills with details of the problem. We will contact the Cleaning Co-ordinator, Site Services or whoever is appropriate.
Computer Problems

Troubleshooting

- Shutdown the computer to check if it is a temporary problem.
- Remove power lead from back of machine, replace and restart computer.
- Some machines “hibernate” and appear to be turned off with black screen. Unplugging power will resolve this issue.
- If it is a simple problem (i.e. monitor lead unplugged, faulty power lead etc) then resolve the problem.
- A computer may not start due to faulty peripheral devices (keyboard, mouse, network card etc). Resolve the issue by first plugging out all the peripheral devices and then replugging them individually. In this manner, the faulty device can be identified and replaced.

Reporting the Problem

If you cannot resolve the issue, check the POST lights of the computers.

Optiplex 745(501): Flashing Orange power button on the front of the case
HP DC6800 (408): Flashing Orange power button on the front of the case
HP DC7900 (303): Flashing Orange power button on the front of the case

These, along with the light in the power button, are diagnostic lights that Dells use the identify hardware problems. Email Bills details of the problem the computer is having, any information that might help, and the combination of lights (if any). Make a note of the status of the machine in the Monkey map.

Wireless Problems

Students are given access to Curtin’s Wireless Network around different spots on campus. Students will often ask you to help them set up their laptops correctly to access this network. There are guides located in the labs and also at http://wireless.curtin.edu.au .
If after going through the wireless setup guide the student is still unable to connect to the wireless network you can try any of the following strategies

**General Strategy**

- Disable third-party firewalls and software.
- Get the students permission prior to uninstalled or disabling software permanently.
- Students wishing to update windows from campus can do so by using fixed points in the library (Building 105).
- Try a single or combination of Entrust and Digicert
- Get the student to enter the login details at least 5 times or till the Digicert warning window appears and select ok or connect.

**Third-party wireless software that is bundled with laptops at time of purchase**

- Disable or uninstall the software and use windows to connect to the wireless networks.
- Curtin wireless networks favours the connection through the default windows wireless connection instead of third-party software.
- Try to use the software to connect to the Curtin network. (See: Connecting to network using Intel PROSet )
- Uninstall third-party software with student consent.

**Anti-virus software**

- Disabling all anti-virus software allows the student to connect to the network successfully.
- Advise student to re-enable their anti-virus outside Curtin networks.
Entrust and Secure Server Certificates

- Absence of these certificates indicates that the student has to update their operating system.
- Windows in particular can be updated by going to Start > Control Panel > Automatic updates.

Inability to browse even though settings are valid

- Make sure LAN settings are selected to 'automatically detect settings':
- Open internet explorer
- Tools > Internet options > Connections tab > LAN settings >
- Check automatically detect settings
- Uncheck Use automatic configuration script
- Uncheck Use proxy server for your LAN
- Click OK to confirm settings
- TCP/IP settings are automatic:
- Start > Control Panel > Network Connections
- Right-click on wireless networks
- Click on properties
- In the new window go to General tab
- In the 'This connection uses the following items' scroll down and select Internet Protocol (TCP/IP)
- Click on properties
- Select Obtain IP address automatically
- Select Obtain DNS server address automatically
- Click OK to confirm settings

Logging wireless calls

- Standard procedure must be following when logging a call. (See procedure for logging calls in knowledge base)
- Wireless calls must be raised to BSSUPPORT.
Action to be taken on other operating systems

- Apple and Linux - Setup guide must be followed.

Other Information

- Check wireless credentials in the before troubleshooting for laptops.
- Make sure the wireless card is switched on.

Conditions of Use of ICT Equipment

The full Curtin Policy is available at

http://policies.curtin.edu.au/documents/is_conditions_of_use.doc

Activities prohibited in the Abacus Labs

- Any use of this computer for non-academic purposes
- Any activity that breached Curtin copyright policies
- Viewing or downloading of movie and video material, including trailers and sample clips
- Downloading of music, including MP3’s
- Listening to music/radio through the internet
- Watching online news/ TV broadcasts
- Accessing, viewing and/or downloading pornography
- Introducing viruses or other software designed to interfere with the normal operations of systems
- Downloading excessive amounts of data, generating excessive load, over use of storage capacity, network traffic etc
- Online chatting
- Gaming of any sort
- Consuming food or drink (bottled water is permitted)
- Leaving bags or other personal items unattended – Items left in the lab for long periods of time will be removed to the helpdesk
- Using thumb drives or external storage devices for non-academic purposes.
The Conditions of Use and the list of prohibited activities always apply irrespective of whether the lab is full or not. There can be no turning a blind eye.

The conditions of use are given to us by the University and “Any use of this computer for non-academic purposes” means exactly that. The Abacus lab facilities are not be regarded as a free internet café as all traffic incurs a cost. However, Abacus staff need to exercise careful judgement about what they might interpret as computer use for non-academic purposes given the wide range of possible study areas that students might legitimately be researching.

**Procedure – Abuse**

For all infringements – including a first offence – add full details to Norte. The more details, the easier it is to investigate.

**Low Level Abuse (chat programs, streaming media etc)**

First Offence  - Warn offender and request that they shut down any such activities.
 - Take Details and log in Norte

Second Offence – Take details and screen captures
 - Email details to Mark Oliver
 - log details in Norte

The offender will be sent a disciplinary email. At the discretion of IS an appropriate ban will be applied.

**Medium Level Abuse (low level porn, downloading and saving mp3/video on external device etc)**

First Offence  - Warn offender and request they shut down any such activities.
 - Take details and screen captures
   - Email to Mark Oliver
   - Log details in Norte

The offender will be sent a disciplinary email.
NOTE when using RemotelyAnywhere, take a number of screen captures.
Save as jpeg or png but not bmp as the files are huge. Send these directly to Bills but not to the Abacus mailing list.

Second Offence – Take details and screen captures
- Email to Bills
- Log details in Norte

The matter will be escalated and at the discretion of IS an appropriate ban will be instituted. The case may be referred to Information Security for investigation.

High Level Abuse (illicit content eg paedophilia, bestiality etc)
- No warnings are to be given to the offender
- Take student details and screen captures
- Immediately contact Bills
- Wait for Bills or to attend – if after hours call security to remove student
- If possible do not allow the student to log off, and mark the machine as out of order (turn off the monitor but leave the computer running). This allows evidence to be captured.
- Forward all details directly to Bills. Do not send to the Abacus list.

The matter will be escalated and referred to Information Security for investigation.

In all cases, feel free to contact Bills. If after hours you may eject offenders from the lab. Call Security on x4444 if you have problems.

By logging onto the computers, all students have accepted the Conditions of Use. Ignorance is not a valid excuse, and they have no right to threaten you, abuse you or make you feel uncomfortable in any way.
**Emergency Evacuation**

In the event of any fire, emergency or drill, the siren alarm should sound. Treat all such alarms as the real thing.

Your job is to:

- Wear your white floor warden hat to identify you as a person in charge.
- One staff member immediately begins evacuating everyone from the labs, checking behind and under all desks.
- One staff member reports to Building Warden immediately to receive any further instructions.
- Students must leave promptly - no "I'm waiting to save my work" excuses. Check both male and female toilets, knocking as appropriate.
- Direct everyone to the appropriate assembly point, taking any necessary instructions from the Building Warden (who will have a yellow hat).
- Stand near lab doorways to ensure nobody can re-enter the building until the all-clear is given.

**Lab Specific Procedures**

**Evacuation Procedure Abacus 303**

Put on your white Warden hats. One staff member immediately begins evacuating everyone from the labs, checking behind and under all desks. One staff member reports to Building Warden to receive any further instructions.

The Building Warden will be positioned at the Fire Panel next to the male toilets on the ground floor. Meet here and await instructions. You then return to the lab and assist evacuating the ground floor. This includes the male toilets.

Evacuation assembly point for 303 is far side (library side) of Henderson Court.

Students are not allowed to exit via the East external 303 door. You need to ensure that students do not gather outside 303 or head over to Chemistry, but go far away from the buildings to the far side of grassed area.
Evacuation Procedure Abacus 408

Put on your white Warden hats. One staff member immediately begins evacuating everyone from the labs, checking behind and under all desks. One staff member reports to Building Warden to receive any further instructions. The Building Warden will be positioned in the foyer with the elevators at the Fire Panel. Meet here and await instructions. You then return to the lab and assist evacuating the ground floor. Check all areas of the ground floor of building 408. This includes the male, female and disabled toilets, the study rooms at either end of the foyer and the foyer itself.

For 408, the evacuation point is Carpark 24. This is the Orange Business carpark east of the 408 building & north of the 407 building. Students are not to gather at the roundabout, as this obstructs the fire engines' access to the buildings.

Evacuation Procedure Abacus 501

Put on your white Warden hats. One staff member immediately begins evacuating everyone from the labs, checking behind and under all desks. One staff member reports to Building Warden to receive any further instructions. The Building Warden will be positioned just inside the northern doors next to the grey fire alarm panels which are on the wall on the left as you go out. You then return to the lab and assist evacuating the ground floor. Check all parts of the lab, common room and female toilets.

The assembly point for 501 is the grassed area on the eastern side of 208. That is, out the northern doors, turn right then left to the grassed area.

The southern doors out to the car park should not be used for evacuation as that is where the fire and emergency vehicles will arrive. However, if fire blocks the northern doors and you have to use the southern door, you may have to smash the small glass panel (with your elbow) if CARDAX does not automatically unlock the door.
**Lost Property**

Student Central is responsible for lost property found on campus.

All items of lost property should be taken to Student Central each Friday morning. Fill out the Lost Property Receipt book and place the item in one of the bags along with the appropriate receipt page. The fill out the Lost Property Register in Excel.

Do not email the student to advise them we have their item - this is causing problems in Student Central - students often arrive sometime after the email and the item has already been disposed.

Whilst this may seem obvious with such things as passports, credit cards, wallets, mobile phones, calculators and expensive glasses, it is important we do not retain **anything** in the labs.

Items should be placed in the lost property box and taken to Student Central each morning. Students making enquiries about lost property should always be directed to try Student Central.

The full Curtin policy on lost property is at


**Printers**

**Printer Problems**

Try the following before reporting the printer as out of order.

- **Paper** – check for any paper jams and clear if necessary. If no obvious jam, check paper, fan at both ends and re-insert into paper tray. Make sure that the guides on the paper tray are set to A4 and not “letter” or “custom”. Do not overfill the paper tray.
• **Toner** – (if not simply out of toner) Check the toner cartridge by pulling it out and reinsert. If the problem persists, replace with a toner from the same type of printer which is known to be working. If it now works, return the borrowed toner to its original machine and install a new toner. Place the faulty toner cart in a box and mark as faulty.

**Please not do not shake the toners for whatever reason.**

Powering down and restarting the printer and card reader will sometimes clear temporary logic problems.

If you’re unable to fix the problem, report it to who will arrange for the maintenance contract technician (Steve) to attend. Mark it in Monkey as out of order. It is essential that you collect as much information about the problem as possible. For example, record error codes shown on the display or collect a sample of the printout that shows the problem and mark it for attention of Steve.

**Occupational Health And Safety**

Curtin University has a commitment to occupational safety and health. The university's policy details the responsibilities of all parties for managing and improving safety and health in the workplace. The policy will assist the University, its management and its staff, to comply with their obligations under the Occupational Safety and Health Act 1984 (WA) - the Act.

This policy applies to all University managers, staff, contractors, associates and visitors on all University campuses.

A copy of the policy is available via the following link:


**Bullying**

*Prevention & Management of Bullying @ Curtin*

Bullying is defined as repeated, unreasonable or inappropriate behaviour directed towards a person, or group of persons, that creates a risk to health and safety
Curtin University of Technology acknowledges the risk bullying poses to its management, staff and students.

The Policy and Procedures for the Prevention and Management of Bullying have been developed in accordance with national guidelines, legislative authorities, and in consultation with representatives from Curtin’s management, staff and students. The University’s bullying policy can be viewed through the EduSafe website:


**EduSafe**

The University is committed to providing and maintaining high standards of safety and health in the workplace. This will be achieved by maintaining a safe and healthy working environment in consultation with staff and safety and health representatives and through continually improving systems for managing safety and health.

EduSafe provides professional advice and services in:

- Occupational Safety and Health
- Workers' Compensation
- Injury Management
- Risk Management

More information is available via the EduSafe website:

http://edusafe.curtin.edu.au/curtin
Making the Workplace Safe
EduSafe have produced a publication detailing how to ensure a safe work environment.

The University is committed to the integration of safety and health into line management systems in accorded with ‘best practice’ standards. There are responsibilities placed on managers, supervisors and employees under the Occupational Safety and Health Act, 1984 (WA) to ensure a safe and healthy workplace. The manual provides a guide for managers and supervisors in meeting their occupational safety and health obligations.

This publication is available through the EduSafe website at:

Safety At Work
WorkSafe is the government agency that oversees workplace safety. The principle objectives of the occupational safety and health laws and regulations in Western Australia are to promote and secure the safety and health of people in the workplace. As the agency charged with administering these laws,

WorkSafe has many responsibilities ranging from providing administrative support to the Commission; managing certification of machinery; conducting community education programs; and more.

More information is available on the WorkSafe website:
http://www.worksafe.wa.gov.au/newsite/worksafe/content/worksafe/wswaindx001.html
Safety Priorities for Manual Handling

WorkSafe is working with employers, employees and employee representatives to set up and maintain systems of work so that employees are not exposed to hazards. One of the priority areas is manual handling. Workplace injuries are often sustained through incorrect manual handling techniques.

For further information on WorkSafe Priority Areas please see the WorkSafe website:

http://www.worksafe.wa.gov.au/newsite/worksafe/content/topics/wswagenl0003.html
Passwords Quick Reference

Lab Computer Administrator Logon
Username: administrator
Password: administrator password

Desktop Monkey
Username: Staff ID
Password: monkey password

Monkey Website
Username: Staff ID
Password: monkey password

Microsoft Outlook
Username: Staff ID
Password: Oasis password

Oasis
Username: Staff ID
Password: Oasis Password

Citrix
Username: Staff ID (must capitalise letter)
Password 1: Oasis password
Password 2: Citrix password
HP OpenView

Username: oasisX (see computer)
Password: same as username

Cardax

Log in to citrix first (Novell Password)

Username: Staff ID with a Capital Letter Eg. 212320F
Password: Set on Activation

NOTES
204 LVL 3 IT HELP DESK Manual

**Daily Duties:**
Sign in, check staff emails
Power cycle the 3 printers in next room and fill paper.
- Paper should be ordered once the stock is below 5 boxes (A4) and 3 boxes (A3). You will need to contact S&E IT Procurement
  scieng.itprocurement@curtin.edu.au to order another A4 pallet (pallet = more than 50 boxes) and 5 boxes of A3
- Toner is also under our control, if low or no spare please request an order.
  (Toner cartridges should be kept at least 2 units all the time).

In the top drawer of the desk is where various keys are kept. One of which you will need to take with you when you do the 207 round, it is labelled ‘BLD 207 LVL 3 Printer room’. It is the only copy so do not lose it!
Make sure the 204 shutter is down when you leave the office.

**207 - LVL 3 Printers in Common Room:**
There are two printers here. One is a B/W other Colour. Both do A3 and A4 size prints. I have stored Toner, A4 and A3 paper in the cupboards – keep them stocked.
Fill the printers, check the toner levels.
Make sure the room is locked as you leave. Be careful if you close the locked door once you are inside as the door can only then be opened by key from the outside.
Back in 204,
The enquiries will be similar like in the other ABACUS Labs. Wireless, Printing, etc..
But there will be requests for different Lab access in 204 and the surrounding buildings – 207, 205, 215 and any postgrad rooms.

**Granting Lab Access – Lots to process at beginning of Semester**
First, make them fill out the cardax access request form – it proves who you have given access to.
Secondly, check what year student they are, and their currently enrolled units – in StudentOne.
Once you can see their units and verified they are enrolled – first year units start with 1, second years 2 … etc and you have their signed forms, Only then can you grant them access.
Also remove any last year access groups they may have, like a 2\text{nd} year student with 1\text{st} year access – remove all the previous lab/room access except the ABACUS Labs – every enrolled student should have it by default.

**We are not responsible for the software or the computers in the labs.** Any problems mark it Out of order and call x9000 or email service.desk@curtin.edu.au with the details of lab, program and student details. It will be then made as a service call for Science and Engineering IT.

**CARDAX access groups per Enrolled UNITs**
These are not complete, but a start:
Fourth year lab access group - BEN 204 Engineering 4th/ final year student + parent
Eligible Subjects:
Project 401/402
Civil Eng Project 461/462
research project 1 che491
Mechanical Project 493
Mechanical Project 491
Mechanical Project 493
Civil Engineering Project 462
Mechanical Project 491

Building 205 room 104a - BEN 205 Engineering PLC/SCADA Lab Student + Parents
Eligible subjects:
Instrumentation and Control  402
Control systems 301

Engineering Postgrads, depending on their major look under:
- BEN 204/205/207 Engineering PostGrad
- BEN 207 Spatial Sciences PostGrad

Misc Info:
204 level 3 printer types: 2x HP LaserJet 9050, 1x HP Color LaserJet 9500.
207 level 3 printer types: 1x HP Color LaserJet 5550, 1x B/W HP LaserJet 5100
All the above printers do both A3 & A4 size.

Petroleum Eng Laptops first time use. Also applicable to some Humanities or CBS
Need to be connected via a lab network cable to activate..
For Petroleum:
Login:Student
Pass: p3t3ng2010 - User will then be asked to change password
For others:
Login: StudentID
Password: Student Password

This is just to create the initial profile on the laptop.